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1 Overview  

SiLENSe  software enables one-dimensional (1D) simulation of heterostructures used in 

light-emitting diodes (LEDs) and laser diodes (LDs). The structure can include tunnel 

junctions. The software simulates band diagram as a function of the applied bias, distribution 

of electron and hole concentrations, electron and hole current density, radiative and non-

radiative recombination rates, carrier energy levels and wave functions in the quantum wells, 

emission and gain spectra, internal quantum efficiency (IQE), injection efficiency, etc. 

Mechanical strain due to lattice mismatch between epilayers is calculated and its effect on 

the band structure is included into the model. 

 

Built-in database of material properties includes both zinc-blende (cubic) and wurtzite 

materials, such as AlInGaN, AlGaInAs, AlGaInP, and others. Specific features of III-nitride 

materials like strong piezoeffect, spontaneous electric polarization, low efficiency of acceptor 

activation, and high threading dislocation density inherent in III-nitride epitaxial layers are 

included into the model. The software enables the analysis of graded-index heterostructures, 

which is important for development of novel semiconductor devices by using the bandgap 

engineering principles.  

 

Laser Edition  of the package also enables computation of the waveguide modes and 

prediction of the threshold characteristics. 

 

The software includes a graphical user interface for specification of the input data, starting 

and controlling computations, and built-in visualization of the results (they also can be 

exported in text format for import into any other visualization package). This document is 

aimed in detailed description of the user interface, while the physical model is described in 

"Physics Summary" document.  

1.1 SiLENSe Options 

The current version of SiLENSe  package provides the following options: 

� Calculation of the band diagram, current, internal quantum efficiency etc. for a given 

bias. One can also set up series computations to cover some range of the bias 

variation. 

� Calculation of the carrier wave functions, and the emission and gain spectra from the 

known band diagram. 
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� Plot an integral characteristics of the LED operation for all the computed biases, such 

as I-V curves etc. 

� Simulation of structure operation under external optical excitation (PL simulations). 

� Simulation of characteristics of individual tunnel junctions includes into the structure. 

 

The following options are available in Laser Edition  only: 

� Computation and visualization of the waveguide mode intensity distribution for both 

TE and TM polarizations with account for the birefringence in wurtzite crystals. 

Computation of the optical confinement factors. 

� Analysis of the laser diode operation for selected waveguide mode: 

1. Optical gain. 

2. Optical losses caused by the free carrier absorption. 

3. Threshold current and laser output power. 

2 Installation and Registration 

2.1 Installation  

To install the SiLENSe  , run the installation executable file and follow the installer 

instructions. To uninstall the program, run the unins000.exe file in the program home 

directory or use the respective item in the Programs menu. 

The software is supplied with license protection system based on dongle key which is a 

small USB device. During installation, the user is prompted to install the dongle key driver. 

Local administrator rights are required to install the dongle driver. 

The software needs write permission for its home directory. During installation, the 

parameters of the home directory are changed accordingly. 

2.2 Single node license 

The user can install the software on several computers, for example, on a desktop and a 

notebook. The software will run only if a dongle key with a valid license is plugged into the 

computer. There is a limitation for maximum number of software copies running 

simultaneously (default is 4). The registration procedure is as follows: 

� Plug in the dongle key module. 

� Start the license manager (License.exe) located in the home directory. One can 

also do it by Windows Start button. 
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� Choose the Key config tab and press the Make Key button. The request file  (*.req) 

containing the information about the dongle will be generated. 

� Send the generated request file to STR by e-mail simuled-support@str-soft.com . 

� When a reply from STR is received, plug in the dongle, start the license manager, 

press Accept Key button, and browse fro the license file (*.lic) received from STR. 

� Now one can run SiLENSe .  

2.3 Corporate/department network license 

Corporate/department license allows users running the software on several computers 

within the local area network (LAN). The software may be installed on any computer of the 

network, but the maximum number of running copies of the software is limited by a certain 

number, e.g. 10, specified in the particular license agreement (quotation, purchase order, 

etc.). 

Hereafter, by ‘server’ we will understand the computer where the USB dongle key is 

plugged in. The user should install the dongle key driver on this computer. A special tool 

server.exe called below ‘license server’ should be running on the server computer. After 

start, the respective icon appears in the system tray. The pop-up menu allows one to restore 

the window and inspect the event log or the license server. The Change Port button allows 

the user choose the port number for communication between the software running on other 

computers and the license server. 

To obtain/update the license, on need run the License.exe file on the server 

computer. Further procedure is similar to that described in Sec. 2.2 . 

All the computers running the SiLENSe  software we will call ‘client computers’ 

(running the software on the server computer is also allowed). Installation of the software on 

the client computers is similar to Sec. 2.1, while there is no need to install the dongle key 

driver on client computers. Instead, one should run the License.exe file, choose Server 

config tab, and specify the IP address of the server computer and the port number. The 

Store button saves this information in the Str_Config_SL.cfg file in the software home 

directory. This file is used by the software to communicate with the license server. The 

Remove button clears the file. The Test button allows one to test the communication with the 

license server. 

NB   The following conditions to be fulfilled for running the software on a certain client 

computer: (i) the dongle key to be plugged into the server computer, (ii) the license server to 

be running on the server computer, and (iii) the software running on the client computer to 
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be able to communicate with the license server by the IP address and port number specified 

in the Str_Config_SL.cfg file in the software home directory. 

NB Unplugging the dongle key from the server computer or stopping the license server will 

result in abnormal termination of all the running software copies!  

3 Getting Started  

SiLENSe  project files have *.sls extension and store the following information:  

� Heterostructure, i.e. sequence of layers, their composition, doping, etc. 

� Global physical and solver parameters 

� Material properties 

� Simulation results  

 

NB The software is designed in such a way that all the simulation results stored in the 

project file are always self-consistent with the input data. So the user can not modify the 

heterostructure and some global parameters like the temperature if there are some results 

stored (see description of the Tools->Unlock Project menu item).  

3.1 Materials Properties 

There is a special Properties Editor  tool for editing the materials properties (see detailed 

description in Sec. 7). It provides a unified way to set up the material properties of binary 

semiconductor compounds and their alloys. The material properties are saved in the special 

project file of the Properties Editor  (*.matprop). All the computational modules of 

SiLENSe  load material properties from these files.  

 

Generally, the materials are split into two types: (i) materials of fixed chemical composition, 

like GaN, GaAs, InP, etc. and (ii) alloys with variable composition, like AlxInyGa1-x-yN, AlxGa1-

xAs, etc.  

 

The default database of the material properties is supplied with SiLENSe , but users can 

modify the material properties or add new materials and alloys. 

 

Creating a new SiLENSe  project file, one should specify the Properties Editor  project file 

(or another SiLENSe  project file) from which the material properties will be loaded. In the 
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Material properties tab window, the loaded values are shown in the read-only mode, but one 

can use Material Properties -> Edit menu item to change the data. 

3.2 Heterostructure  

A heterostructure is described as a sequence of layers. For each layer, one should specify 

the thickness, material composition, doping, and other parameters which can not be 

calculated from the composition. 

NB The heterostructure layers can be listed from bottom to top or from top to bottom. User 

needs to choose the appropriate crystal orientation in the Heterostructure tab window and 

appropriate direction of current in Global parameters tab window. 

NB As SiLENSe  is aimed in simulation of the active region, only central part of the 

heterostructure can be specified, starting from n-type current spreading layer to p-type 

current spreading layer. Also, the thickness of the current spreading layers can be reduced 

down to ~500 nm in order to speed up the computations. 

NB The simulations are 1D and the current is assumed to flow through the while structure. 

So for structures grown on insulating substrates, such as GaN on sapphire, the substrate 

and nucleation/buffer layer(s) should not be included into the simulation. 

3.3 Global Parameters  

In the Global parameters tab window, the user can specify some global physical parameters, 

such as the junction temperature and some internal solver parameters controlling the 

numerical computations. The parameters related to analysis of laser diodes are shown in the 

Laser parameters tab window. A default set of the parameters is loaded automatically in a 

new project. The solver parameters are discussed in details in Sec. 5.6. 

3.4 Running the Calculations 

Most of the calculations can be started from the Run menu. Some of the Run menu items 

are duplicated by the respective buttons in the toolbar and/or hot keys. The menu item ‘Stop’ 

allows the user to abort current calculation. The calculation of the emission and gain spectra 

can be started from the LED Results or Laser results or  PL Results windows. One can open 

them by the respective items in Window menu or by the respective button in the toolbar. 

3.4.1 Band Diagram and Carrier Fluxes 

To start single calculation of the band diagram, use the Single Calculation menu item. The 

modal window appears where you will be prompted to enter the p-n junction bias and start 
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the computations. The solver window appears where the iterative solution process is 

described. The user can abort the computations by the Stop button. When the calculations 

are complete, the simulation results are shown in the Results tab window containing several 

plots. To switch between the plots, use the vertical tabs along the left side of the plots. 

 

Series calculation menu item allows calculations for a number of bias values at once. The 

modal window appears with the list of biases which will be processed. The user can add a 

single bias by the Add button, while the Add sequence button enables one to add a 

sequence of biases varying from the Start bias to the End bias with a given Number of 

intervals. The entered biases can be edited or deleted by the buttons Edit and Delete, 

respectively. Use the button Delete All to clear the list. 

 

Series calculation for SpeCLED menu item allows automatic computations for a given range 

of the p-n junction bias and temperature. List of biases is specified exactly as for series 

calculations, and the temperature list is specified in a similar way. When computations are 

completed, a .txt file with the name similar to the .sls name is generated. This file includes 

the tabulated dependence of the key parameters (current density, IQE, emission 

wavelength, etc.) on the applied bias and temperature. This file can be imported into 

SpeCLED  software for 3D simulation of the current spreading and heat transfer in the LED 

chip. 

NB The data for SpeCLED  module should cover the whole range of the current density and 

temperature expected during 3D chip simulation. The recommended bias step is 0.01-0.05 V 

(it is OK not to run computations for the current density far below than that of interest). The 

recommended step for the temperature is 5-20 K. 

3.4.2 Carrier Wave Functions, and Emission and Gain Spectra 

The carrier wave functions, and the emission and gain spectra are calculated from the 

already known band diagram. To start the calculation, one should open the LED/Laser/PL 

Results window, select the desired bias, and use the Run | Wave functions and spectrum 

menu item or the respective button. The results are displayed in the Spectrum tab window 

containing two tabs with plots, Band diagram and wave function and Spectrum. 

 

The list of individual quantum wells appears on the right of the former plot. An individual 

quantum well can be selected in the graph by the vertical cyan stripe initially located in the 

first quantum well. This stripe can be moved from one well to another either by choice of the 
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well number with the mouse in the quantum well list or by pressing the keys “→”, “←”, “↑”, 

and “↓” on the keyboard.  

 

The list of the localized state energies of the carrier in the selected quantum well is given in 

the mini-windows on the right of the quantum wells list. To show/hide the wave functions in 

the main graph, use the check boxes in the mini-windows Electrons, Heavy holes, Light 

holes, and Split-off holes, where the energies of the respective energy states are indicated.  

 

The Spectrum plot shows the emission and gain spectra of individual quantum wells, as well 

as the total spectra. The user can switch the values of X-axis between the photon energy 

and the wavelength by the respective tab. 

 

3.4.3 I-V Characteristic and Internal Quantum Efficiency 

To get the I-V curve, one should open the LED Results window, select the desired biases, 

and use the Show | I-V Characteristic menu item or the respective button. The modal 

window appears with three plots. The former two plots represent the current density as a 

function of the bias and the internal quantum efficiency variation with the current density, 

respectively. The last plot is introduced to rely the calculated current density with 

experimentally observed I-V characteristics by qualitative accounting for the series and 

contact resistance. The user is prompted to specify the LED area, the series resistance, and 

the contact resistance for the n- and p-contacts. The current and voltage are calculated as 

described in Sec. 7 of [1]. 

3.4.4 Waveguide Modes 

To compute the electric/magnetic filed distribution of the waveguide modes, one can use the 

Run | Waveguide Modes menu item. The modal window appears where one will be 

prompted to enter the light wavelength. When calculations are complete, the results are 

shown in the Waveguide tab window. 

3.4.5 Laser Characteristics 

To simulate operation of edge-emitting laser diodes, a number of additional parameters to be 

specified in the Laser parameters tab window: cavity dimensions, mirror reflectivity, 

polarization (TE/TM) and index of the mode (here one should choose the mode with highest 

optical confinement factor, which will reach the threshold first). 
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Run -> Single Calculation With Laser and Run -> Series Calculation With Laser menu items 

allows running simulations at specified bias (list of biases) with self-consistent account of 

stimulated recombination in the active region (the details are given in [1], Sec. ‘Laser 

Characteristics’). Simulations will look similar to LED calculations, while results are stored 

into Window -> Laser Results  and Window -> Laser Characteristics  windows. 

Run -> Laser Characteristics (Simplified Model) menu item allows to run a simplified laser 

model to compute the threshold current without self-consistent account of the stimulated 

recombination. The program will seek for the threshold performing calculation of the gain 

and loss for each bias and comparing them. The user can see the computation progress in 

the progress bar and stop calculations by the Stop button. Results are stored into Window -> 

Laser Characteristics (Simplified Model) window. 

3.4.6 PL simulations 

PL simulations be started by Run menu items Run PL and Run PL Series. User needs 

specify the excitation power density. PL simulations are stored in Window -> PL Results  

window and handled similar to simulations of the band diagram at the given bias. To get PL 

emission spectrum, one needs open list of PL results by using Window -> PL Results menu 

item, select the results for desired excitation power, and start simulation of the emission 

spectrum as described in Sec. 3.4.2.  

3.4.7 Simulation of individual tunnel junction 

One can start simulation of i-th tunnel junction by using Run -> Run Tunnel Junction -> TJ#i 

menu item or by selecting the tunnel junction in Heterostructure tab, using Heterostructure -> 

Edit Tunnel Junction menu item, and using Run TJ button. Then tunnel junction will be 

simulated for the specified range of bias and its j-V characteristic will be shown in the 

window with the tunnel junction parameters. If Save TJ Results checkbox is checked, the 

results (band diagram, carrier concentration, etc.) will be stored in the project file and can be 

inspected by using Window -> Tunnel Junction Results -> TJ#i menu item. 

3.5 How to Load, Export, and Delete the Simulation Results 

The project file contains some simulation results related to the project. The Window | LED 

Results menu item or the respective button opens the LED Results window with the table of 

the results which were stored in the project file or computed during the current session. The 

table includes an integral data like the bias, current, internal quantum efficiency etc. To load 

a result in the Results tab window, one should choose the result by single mouse click and 

use the Show | Current result menu item or the respective button. A double-click on the 
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respective row of the table has the same effect. One can use the Edit | Delete selected 

menu item or the respective button to delete results selected by the checkboxes in the left 

column. 

The Export menu allows one to save the current result or the I-V curve as a text file. The 

output formats are described in details in Sec.5. 

4 Graphical User Interface 

The chapter describes the user’s options available to control the data input, simulation of 

LED characteristics, and visualization of the simulation results within the Graphical User 

Interface (GUI). 

4.1 Menu and Toolbar  

The Menu contains the File, Heterostructure, Material properties, Run, Export, Tools, 

Window, and Help items. The File menu allows one to create new project, open an existing 

project, save changes in the current project file, and exit the program.  

 

Fig. 1. Load material properties to the new project. 

 

The menu item New is for creating new project. The modal window will appear where the 

user will be asked for the file with the material properties (see Sec. 3.1). The window also 

contains the lists of materials and alloys described in the selected file. The green tick and the 

red cross show if the respective item contains all the properties necessary for calculations. 
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The Heterostructure menu contains different operation with the heterostructure layers. Most 

of these actions are duplicated by the respective buttons in the Heterostructure tab window. 

 

The Material properties menu allows the user to export the data from the current project to 

the separate material database file, overload the existent data from other SiLENSe  project 

or material database file (import of the material properties), and open Properties Editor  to 

edit the current dataset. 

 

The Run | Single computation menu item starts single computation. The modal window 

appears where the user is prompted to input the bias. The Run | Series computations menu 

item allows one to perform a set of calculations for a number of bias values. The modal 

window appears with the list of biases which will be processed. The user can add a single 

bias by the Add button, while the Add sequence button enables one to add a sequence of 

biases varying from the Start bias to the End bias with a given Number of intervals. The 

entered biases can be edited or deleted by the buttons Edit and Delete, respectively. Use 

the button Delete All to clear the list. 

    

Fig. 2. Series calculations modal window (left) and series calculation for SpeCLED (right). 

 

Series calculation for SpeCLED menu item allows automatic computations for a given range 

of the p-n junction bias and the temperature. List of biases is specified exactly as for series 

calculations, and the temperature list is specified in a similar way. Data for SpeCLED (a 

single *.txt file including key results for all temperatures) are generated automatically, and 

SiLENSe files (*.sls) with complete results are optionally saved for all temperatures. 

 

During the computations, the bias values are indicated by colored rectangles. Grey color 

means that the calculation for the task has not been started, blue color marks the current 

task, successfully finished and failed tasks are shown by green and red colors, respectively.  
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The Waveguide Modes item of the Run menu allow one to start the computation of the 

waveguide modes. 

 

The Single Calculation With Laser and Series Calculation With Laser items of the Run menu 

allow one to start simulation of the laser operation at the specified bias (or series of biases). 

 

The Run Tunnel Junction -> TJ#i item of the Run menu allow one to start simulation of i-th 

tunnel junction according to the parameters specified for this tunnel junction. This menu item 

works similarly to the following sequence of actions: (i) select the tunnel junction in 

Heterostructure tab, (ii) use Heterostructure -> Edit Tunnel Junction menu item, and (iii) use 

Run TJ button. 

 

The Run PL and Run PL Series items of the Run menu allow one to start simulation of PL 

experiment at the specified excitation power density (or for several powers). 

 

The Stop item of the Run menu allows the user to abort current calculations. 

 

Some of the Run menu items are duplicated by the respective buttons in the toolbar and/or 

hot keys.  

 

NB The calculation of the emission spectrum and I-V curve to be started from the LED 

Results window. 

 

The Export menu enables one to save computed results as a text file. The band diagram for 

a certain bias or the I-V curve to be exported from the LED Results window. Save current 

chart item allows the user to save current chart as a graphic file. 

 

The Tool | Unlock Project menu item and the respective button in the toolbar are enabled 

only if there are some results computed during the current session or previously saved in the 

project file. Then the user can not modify the heterostructure and global physical 

parameters. This limitation is introduced to make sure that the input data and the simulation 

results are self-consistent. Use this item or the respective button to delete all the results and 

enable modification of the heterostructure and global physical parameters. The confirmation 

dialog appears with warning that all results will be deleted. To keep the results, the user 
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should (i) save the project to store the result obtained in the current session, (ii) save the 

project under a new name, and (iii) unlock the project and modify it. 

The Tool | View Iterations menu item and the respective button in the toolbar allow one to 

inspect the iterative solution process. When this option is turned on, the plots in the Results 

tab window are updated after each iteration. However, it might make the computations 

slower. 

 

The Window menu is to open other windows, such as solver window and different simulation 

results. The most important is the LED Results window containing a table of processed 

biases and some integral data like current density, internal quantum efficiency, etc. 

 

The Help menu includes the About option providing the user with brief information on the 

version of the software and license. 

 

The toolbar contains buttons for a quick access to the main options. 

 

4.2 Tabs of the Main Window 

4.2.1 Heterostructure  

The Heterostructure tab window allows the user to specify the LED heterostructure 

considered to be a sequence of semiconductor layers (Fig. 3). To manage layers, one can 

use the Heterostructure menu items or buttons from the vertical toolbar in the left part of the 

tab. Use Add Layer, Delete Layer, Edit Layer, Move Layer Up, and Move Layer Down to 

create, delete, and move the layers. One can copy the selected layer into a buffer and insert 

the layer from the buffer after the selected layer by the buttons Copy Layer and Insert Layer, 

respectively.  
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Fig. 3. Heterostructure tab window. 

 

When the user clicks the Add Layer button, the pop-up menu appears where the material 

type should be chosen from the lists of available materials and alloys. The Edit Layer button 

allows one to edit the layer properties (Fig. 4). The General properties section contains the 

name1, thickness, composition2, doping, and mobilities of electrons and holes. One may view 

the specified composition profile by using the Preview composition button. The additional 

properties are the electron and hole lifetimes related to the point defects, relaxation 

parameters (degree of the strain relaxation at the left interface of the layer or the relaxed 

layer constant a), and dislocation density. Section ‘Composition fluctuations’ allows the user 

to input parameters related to Indium composition fluctuations in InGaN material. 

Layer composition and relaxed layer constant a may be specified by using a custom 

function, defined by user by a script or by a table which can be imported from a text file. To 

use function, one needs pick up the function name in the respective drop-down list. One can 

edit functions by using " Heterostructure->Functions" menu item. 

                                                

1  The layer name is not used by the code and introduced just for convenience. 

2  The composition is required only for layers made of alloys. 
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Fig. 4. Layer properties window. 

 

One should mark quantum well (QW) layers by the checkbox Quantum Well in the Layer 

properties window. The marked quantum wells are indicated in the layer list by purple rows. 

Each “purple” region is treated as a separate QW.  

Warning:  The user is responsible for adequate selection of the quantum wells. If the QW 

consists of several layers (for example, triangular or trapezoidal QW) , all the layers should 

be marked as QW. It is recommended not to mark barriers as Quantum Well layers. In some 

special cases, one can mark barriers as QW layers to see the coupling between the QWs. 

The details are described in [1] in the section related to the spectrum calculation. 

 

A Periodic structure button is introduced to simplify input of multiple quantum well structures. 

To create a periodic structure, one should select all layers in one period and use the Periodic 

structure button. The user is prompted to input a number of periods. When periodic structure 

is created, the number of periods is shown in the layer list, as seen in Fig. 3 for layers 5 and 

6. To delete the periodic structure, one should use the Periodic structure button and input 0. 

The heterostructure can contain several periodic structures. Creating a new periodic 

structure overlapping with the existent ones will clear older periodic structures overlapping 

with a newly created one. 

 

The Orientation combo box allows the user to specify the heterostructure orientation. For 

zinc-blende (cubic) materials, three orientations are supported: [001], [011], and [111]. For 

wurtzite III-nitride materials, along with conventional [0001] orientation, a number of nonpolar 
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and semipolar orientations are supported. Respective inclination angle is shown below the 

combo box. Choosing "Custom Inclination Angle" in the combo box allows one to specify a 

custom inclination angle in [0,180] range. 

 

The bottom area of the Heterostructure window contains a plot representing variation of the 

following layer properties throughout the whole heterostructure: doping, mobility, degree of 

relaxation, dislocation density, lifetimes of recombination at point defects, and DOS tails. 

One can switch between the different variables by choosing the respective tabs. 

4.2.2 Tunnel Junctions  

Tunnel junction regions are highlighted in the table with heterostructure layers by grey color 

and index of the tunnel junction. Tunnel junction regions can not overlap with periodic 

structures or other tunnel junctions. 

 

To create new tunnel junction region one needs select several adjacent layers in the table 

(similarly it is done for creating a periodic structure) and use Heterostructure -> 

Create/Delete Tunnel Junction menu item. If the selected range of layers overlaps with 

another tunnel junction or periodic structure, a dialog window will appear where user will be 

able to choose between three options: 

� Delete old periodic structures and tunnel junctions and create a new tunnel junction 

in the selected range of layers 

� Delete old periodic structures and tunnel junctions (this option enables deleting 

tunnel junctions) 

� Cancel (quite dialog with no changes) 

 

To delete tunnel junction one needs select a layer within the tunnel junction, use 

Heterostructure -> Create/Delete Tunnel Junction menu item, and choose Delete old 

periodic structures and tunnel junctions in the dialog. 

 

To edit tunnel junction parameters, one needs select a layer within the tunnel junction and 

use Heterostructure -> Edit Tunnel Junction menu item. Then a window appears where one 

can set the parameters (Fig. 5). The button Update Plot plots the j-V curve of the tunnel 

junction. If Simulation type is chosen, it will cause simulation of the tunnel junction. J-V curve 

will be plotted in the same window. The band diagram, carrier concentrations, etc will be 
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saved in "Results -> Tunnel Junctions -> TJ#i" window if check box Store TJ Results is 

checked. 

 
Fig. 5. Tunnel junction parameters window. 

 

Briefly, tunnel junctions are included into simulations as following. 

� First, the tunnel junction is simulated as a separate object, and dependence of the 

tunnel current on the local bias applied to the TJ is calculated. For each local bias, 

the band diagram of the tunnel junction region is calculated assuming Fermi levels to 

be constant and separated by the bias. Then the tunneling current is calculated in a 

conventional way. For each energy, the tunneling probability is calculated. The total 

tunneling current is calculated by integrating over the energy the product of the 

tunneling probability and factor describing presence of carriers at given energy. 

Alternatively, j-V characteristic of the tunnel junction can be specified by parametric 

approximation or user-defined function. 

� Second, the whole heterostructure is simulated as usual, and the tunnel current is 

taken from the table generated at first step. Conventional drift-diffusion current in the 

tunnel junction region is also considered in the model. 

 

NB When user starts simulation of the whole structure (LED, PL, laser), the simulation of all 

tunnel junctions included into the structure is started automatically. There is no need to start 

simulation of tunnel junctions manually prior to main simulation. 



 
 

 

    

SiLENSe User Manual 21 of 48 

 

4.2.3 Import of the heterostructure from a STREEM output file 

One can import the heterostructure from an output file of STR STREEM InGaN software by 

using Heterostructure->Load Layers From STREEM file menu item. Then the following 

procedure will be performs automatically: 

� Old set of layers is deleted 

� Old set of heterostructure functions is deleted 

� According to the file, tabulated functions describing spatial variation of the layer 

composition and relaxed lattice constant a are created for each layer. 

� New set of layers is created according to the layer specification in the file. For each 

layer, the material composition and relaxation are specified by using the respective 

functions. All other parameters contains default data and, generally, to be specified 

by the users. 

NB After import of the heterostructure, user need specify all the parameters except to that 

imported from the file (composition and relaxation). Optionally, one can also add more 

layers, delete some layers, correct imported functions, or perform any other corrections of 

the input data. 

 

4.2.4 Global Parameters  

The Global parameters tab window (Fig. 6) represents the parameters applicable to the 

whole simulation and includes four subsections: Physical parameters, Main solver 

parameters, and Spectrum solver parameters. 

 

Physical parameters are as following 

� Temperature. 

� Settings for the quantum potential model. One can switch it on/off, as well as specify 

correction factors. Zero correction factor provide the same results as without 

quantum potential model. 

� Current direction to be specified to enable correct automatic setting of sign of bias 

and current density. The default setting is "negative", which corresponds to situation 

in version 6.4 and below (heterostructure is always specified from n-side to p-side, so 

z-axis is directed from n-side to p-side, and so forward current is directed opposite to 

z-axis). 
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� Algorithm to select the tunnel junction region in the computation of the whole 

structure. Several types are available, the recommended ones are "old" and 

"minmax". 

 

Meaning of the solver parameters is described in detail in Sec. 5.6. 

 

 

Fig. 6. Global parameters tab window. 

 

4.2.5 Material Properties 

The Material properties tab window (Fig. 7) shows the loaded materials properties in the 

read-only mode. The Material properties menu allows the user to export the data from the 

current project to the separate material database file or overload the existent data from other 

SiLENSe  project or material database file (import of the material properties). The import can 

be done only if the new material database contains valid properties for all the materials used 

in the heterostructure. 
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Fig. 7. Material properties tab window. 

 

4.2.6 Results 

The Results tab window (Fig. 8) includes 8 plots presenting the simulation results: band 

diagram, electric potential and electric field, carrier concentrations, recombination rate, 

Shockley-Read-Hall lifetimes, current density of electrons and holes, strain components, and 

spontaneous and piezoelectric polarization. Available manipulations with graphs are 

described in detail in Sec. 4.3.4. 
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Fig. 8. Results tab window. 

 

4.2.7 Spectrum  

The Spectrum tab window is divided into two tabs: Band diagram and wave functions and 

Spectrum. The former tab (Fig. 9) contains a plot with the band diagram and carrier wave 

functions as well as a list of the quantum wells. The respective quantum well can be chosen 

by the mouse click and automatically marked by the cyan vertical stripe in the graph window. 

The movement from one well to another can be proceed either by direct choice of the well 

number by mouse or by the use of keyboard keys “→”, “←”, “↑”, and “↓”. 

 

The energy levels in the chosen quantum well are listed in the right subsection. The user can 

turn on/off the wave functions in the selected quantum well by the checkboxes near the 

energy values. The total number of the energy levels in the selected quantum well is given in 

the brackets after the carrier type. 
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Fig. 9.  Band diagram and wave functions tab window. 

 

The Spectrum tab window (Fig. 10) shows the spontaneous emission and gain spectra of 

individual quantum wells, as well as the total spectra. The lines can be switched on/off by the 

respective checkboxes in the right part of the window. The user can switch between the 

photon energy and the wavelength by the respective vertical tab. 

 

 



 
 

 

    

SiLENSe User Manual 26 of 48 

 

Fig. 10.  Spectrum tab window. 

 

4.2.8 Laser parameters tab window 

The Laser parameters tab window  (Fig. 11) contains global parameters related to the 

analysis of laser diodes. One group of parameters controls the calculation of the threshold 

characteristics. The user should specify the stripe geometry, reflectivity of the output and 

back mirrors, the polarization and index of the waveguide mode for which the analysis 

should be done. The Additional loss parameter allows one to specify an additional optical 

loss of any source. Next two parameters control the iterative adjustment of the current 

density converted into the stimulated recombination rate. The Initial step parameter means 

that the first initial guess will be the given fraction of the current density converted into the 

radiative recombination. The Gain Fitting Accuracy specifies the accuracy of fitting the 

condition that the total gain equals to the total losses. Use Imported Gain Data flag specifies 

whether user wants to replace calculation of the gain by a user-defined function. If this 

parameters is not "No", Peak Gain vs Current Density Function and Peak Gain Wavelength 

vs Current Density Function are the names of the functions for the maximum gain and 

respective wavelength. The button Edit Gain Import Functions enables editing these 

functions. Use Absorption From Material Data flag specifies whether the free-carrier 

absorption coefficient to be replaced by the absorption coefficient specified in the material 

properties data. 

 

The other group of parameters controls computation of the waveguide modes. Since the 

electric/magnetic field distribution typically is much wider than the active region, for correct 

description of the waveguide one need to describe the thick n-contact layer and the 

substrate. The n-contact layer is assumed to be of the same composition as the first layer in 

the Heterostructure tab window, so one need only input its actual thickness. As for the 

substrate, the user should select the material from the drop-down list containing all the 

materials described in the project. The substrate composition field is enabled for alloy 

materials only. The Substrate thickness in computations parameter specifies the part of the 

substrate included in the waveguide computations. It should just provide an exponential 

decay of the field distribution. Do not input here the actual substrate thickness! The Mesh 

step parameter shows the mesh step used in waveguide computations. 
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Fig. 11.  Laser parameters tab window.  

 

4.2.9 Waveguide tab window 

The Waveguide tab window consists of two tabs: Refractive index waveguide modes and 

Far field. The former tab contains plot of the refractive index for ordinary (magenta line) and 

extraordinary (cyan line) waves (Fig. 12). The distribution of the electric and magnetic field 

intensity for TE and TM waveguide modes is shown by red and blue lines, respectively. The 

user can switch them on/off by the respective checkboxes in the right part of the window. 

The number appearing after the mode index is the effective refractive index β/k. The region 

of negative position represents the buffer layer and a part of the substrate. 

 The Far field tab (Fig. 13) shows the distribution of the far field intensity. 
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Fig. 12.  Refractive index waveguide modes tab window. 

 

Fig. 13.  Far field tab window.  

4.2.10 PL parameters  tab window 

The PL parameters tab window contains global parameters related to PL excitation (Fig. 14), 

which includes the excitation wavelength, the excitation direction, reflectivity of the top and 

bottom boundaries of the structure, and p-n junction bias applied. The reflectivities can be 
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specified directly or calculated automatically by using refractive index of the top/bottom 

layers and of the immersion medium. 

 
Fig. 14.  PL parameters tab window. 

 

4.3 Other Windows 

4.3.1 LED Results 

The Window | LED Results menu item opens the LED Results window with the table of the 

results which were stored in the project file or obtained during the current session. The table 

includes the following data: bias, current density (J), radiative (Jrad) , total non-radiative 

(Jnrad), Shockley-Read-Hall (JSRH), and Auger (JAuger) fractions of the current density, injected 

electron (Jn) and hole (Jp) current densities, leakage current densities of minority carriers (Jn 

right and Jp left),  internal quantum efficiency (IQE), injection efficiency, non-ideality factor (m), 

peak wavelength (Peak WL) and full-width at half-maximum (FWHM) of the emission 

spectrum, sheet carrier concentrations in the active region (n2D and p2D), and averaged 

differential lifetime in the active region. 

 

The menu bar of the LED Results window enables the user to work with the results. 

NB All the menu items are duplicated by the respective buttons in the toolbar. 
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The Edit menu allows deleting selected results as well as select/unselect all the results. The 

user can load a result in the Results tab window by using Show | Current result menu item or 

just by double-click on the respective string in the table. To plot the current-voltage 

characteristics and internal quantum efficiency as a function of bias one should use the 

Show | I-V characteristic menu item. Only selected results will be evaluated. 

 

The item Run | Wave functions and spectrum enables one to calculate the carrier wave 

functions and emission spectrum for the current result (marked by the gray color). To 

calculate the peak emission wavelength for all results, one can use Run | Update Peak 

Wavelength menu item. 

 

The Export menu allows the user to export simulation result into a text file. First two items 

store the current result and I-V characteristic, respectively. Export | All Results in Single File 

menu item allows to export all the results for band diagrams, carrier concentration, and so on 

into a single text file for further analysis. The output formats are described in detail in Sec. 5.  

 

Fig. 15. LED Results window. 

 

Export | Export to SpeCLED menu item allows one to export results for the SpeCLED  

module in old format. It is recommended to use Run -> Series Calculations for SpeCLED 

menu item of the main menu instead (see Sections 3.4.1 and 4.1 for details). 

4.3.2 PL Results 

The Window->PL Results menu item opens PL Results window (Fig. 16) representing a 

table with all completed PL simulations like LED Results window shows results for LED 
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mode. The most data shown in the table is similar to that of LED Results window. New 

columns are excitation power density (ExcPower, W/cm2) and the respective current density 

(J gen, A/cm2). The IQE for PL computations is defined as the ratio of the radiative current in 

QWs to J gen (not to J). All other functionality of PL Results window is similar to that of LED 

Results window. 

 

Fig. 16. PL Results window. 

4.3.3 I-V Characteristic 

The Show | I-V characteristic menu item in the LED Results window opens an I-V 

characteristic modal window with three plots. The former two plots represent the current 

density as a function of the bias (Fig. 17) and the internal quantum efficiency variation with 

the current density, respectively. The last plot is introduced to rely the calculated current 

density with experimentally observed I-V characteristics by qualitative accounting for the 

series and contact resistance. The user is prompted to specify the LED area and series 

resistance. The current and voltage are calculated as described in Sec. 9.2 of [1]. The plot is 

updated when one uses the Apply button. 
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Fig. 17. I-V characteristics modal window. 

 

4.3.4 Overlap Integrals 

This window shows the squared overlap integrals between each pair of the electron and hole 

wave functions. The data for different quantum wells are shown in different tabs. 

 

 

Fig. 18. Overlap Integrals window. 

 

4.3.5 Detailed Spectrum 

The Detailed Spectrum window (Fig. 19) allows inspect fine details of the emission 

spectrum. Tree in the left part of the window shows the total emission spectra and total 

contribution of each subband of the valence band followed by contribution of individual QWs. 

Contribution of each QW is also split into contributions of three subbands and even 

individual transitions. Values after the colon indicate relative contribution of the item in the 

total emission spectrum. If the selected item represents parameters of an individual 

transition, the below table shows its following parameters: relative contribution to the total 

spectrum, squared overlap integral, occupancy factors of the electron and hole energy levels 
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(at zero energy of the lateral motion), and a product of the squared integral and occupancy 

factors. 

One can visualize the emission spectrum of an item by using button with right arrow or 

double click on the item. Then the item will appear in the check list in the center of the 

window. Check boxes allow show and hide individual lines. To remove an item from the 

check list, use the button with left arrow. Button with double left arrow removes all items from 

the check list. Colors of lines resemble colors of the carrier wave functions. Blue lines show 

total emission spectrum and total contributions of an individual QWs (all subbands together), 

while red, green, and orange lines shows contributions of heavy, light, and split-off holes, 

respectively. 

Save button allows to save these data as a text file (the same effect has ‘Export->Detailed 

Spectrum’ menu item in the main window). 

 
Fig. 19. Detailed Spectrum window. 

 

4.3.6 Optical Confinement Factors 

This Optical Confinement Factors window (Fig. 20) shows the optical confinement factors for 

each mode and each quantum well. The column Total shows the sum over the quantum 

wells. The user can sort modes using the following Sort By menu items: 

� Mode Index (First TE) – modes are sorted by their index, TE modes go first. 

� Mode Index (First TM) – modes are sorted by their index, TM modes go first. 
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� Value – the modes are sorted by the value of total optical confinement factor in the 

descending order. This option allows reveal the mode which is most favorable for 

laser generation, i.e. having larger optical gain and, therefore, lower threshold 

current. 

 

 

Fig. 20. Optical Confinement Factors window. 

 

4.3.7 Laser Characteristics 

The Laser Characteristics window presents the laser characteristics. The first tab (Fig. 21) 

includes a table with the following columns: 

� Bias (V) 

� Output optical power (W) 

� Current (A) 

� Current density (A/cm2) 

� Radiative current density (A/cm2) 

� Stimulated current density (A/cm2) 

� Optical gain (1/cm) 

� Total optical loss (1/cm) 

� Optical loss because of the free carrier absorption in the quantum wells (1/cm) 

� Optical loss because of the free carrier absorption outside the quantum wells (1/cm) 

� Wavelength of the gain spectrum maximum (nm) 
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Fig. 21. Laser Characteristics window : Table. 

 

The second tab (Fig. 22) shows the power-current characteristics as well as the threshold current and 

the differential quantum efficiency. 

 

 Fig. 22. Laser Characteristics window : Power-Current characteristics. 

 

The third tab (Fig. 23) shows variation of the optical gain and loss with the current density. 
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Fig. 23. Laser Characteristics window : Optical Gain and Loss. 

 

The fourth tab (Fig. 24) shows variation of the gain spectrum maximum with the current density. 

 

Fig. 24. Laser Characteristics window : Wavelength. 

 

4.4 Exploring Plots 

All the graphs in SiLENSe  support the following operations:  

� Zoom in:  select the region of interest from the upper left to the right down keeping 

the left mouse button pressed. The zoomed region will appear in the plot window.  
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� Zoom out:  select any region in the plot area from the right down to the left upper 

keeping the left mouse button pressed. This action returns a plot to the full-size 

mode.  

� Scrolling:  drug the plot inside the plot area keeping the right mouse button pressed. 

Then the adjacent region of the plot will be displayed. 

NB  Save current chart menu item allows the user to save current chart as a graphic file. 

 

5 Output Files 

The simulation results can be stored as plain text data files. Usually, these files start from a 

header with column names, then data are stored in columns separated by tab. In some 

cases, the structure of the file is more complicated. 

5.1 Band Diagram, Carrier Concentrations, Recombina tion Rate etc. 

The Export | Current result menu item in the LED Results window enables one to export the 

results of main drift-diffusion solver. The following variables are stored in columns separated 

by tab: 

� Position and mesh step (nm) 

� Three conduction bands (Γ, X, and L valleys) and minimum among them, three 

subbands of the valence band and maximum among them, and all these values with 

corrections due to the quantum potential model (eV) 

� Electron Fermi level and hole Fermi level (eV) 

� Electric potential (V) and electric field (MV/cm) 

� Density of electron current, hole current, tunnel current, and total current (A/cm2) 

� Concentration of electrons in three valleys (Γ, X, and L) and total electron 

concentration (cm-3) 

� Concentration of holes in three subbands of the valence band and total hole 

concentration (cm-3) 

� Concentration of ionized donors and acceptors (cm-3) 

� Concentration of states for three valleys of the conduction band and three subbands 

of the valence band (cm-3) 

� Radiative recombination, total non-radiative recombination, Shockley-Read-Hall 

recombination, Auger recombination (cm-3 s-1), and generation rate (for PL 

computations) 
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� Absorption coefficient (for PL computations) 

� Spontaneous, piezoelectric, and total polarization (C/m2) 

� Four strain components in the coordinates related to the crystal lattice: xxu , yyu , zzu , 

and yzu  

� Non-radiative carrier lifetimes due to dislocations and point defects 

� Refractive index (ordinary and extraordinary) 

� Field intensity for the waveguide mode selected in "Laser Parameters" tab 

� Distribution of the free carrier absorption 

� Product of the two above columns (field intensity and free carrier absorption) 

The latter three columns are calculated for the wavelength of laser emission (i.e. peak of the 

gain spectrum for the selected result). 

The Export | All Results in Single File menu item provides export of the same data for all the 

computed results. In this case, a column containing the p-n junction bias is inserted into first 

position. 

5.2 I-V Characteristics 

The Export I-V characteristics button in the LED Results window enables one to export the I-

V characteristic and related values. The following variables are stored in columns separated 

by tab: 

� Bias (V) 

� Current density (A/cm2) 

� Internal quantum efficiency 

� Injection efficiency 

� Peak emission wavelength, central wavelength, and FWHM of the spectrum (nm) 

� Non-ideality factor 

� Total chip voltage (V) and chip current (A) - see Sec. 4.3.3 

� Radiative current density (A/cm2) 

� Non-radiative current density (A/cm2) 

� Current density of Shockley-Read-Hall recombination (A/cm2) 

� Current density of Auger recombination (A/cm2) 

� Current density electrons and holes at external interfaces of the structures (A/cm2) 

� Sheet concentration of electrons and holes in the active region (cm-2) 

� Averaged differential lifetime in the active region (s) 

� Local bias and tunnel current density for each of the tunnel junctions (V, A/cm2) 



 
 

 

    

SiLENSe User Manual 39 of 48 

 

5.3 Carrier Wave Functions 

The Export | Carrier Wave Functions menu item enables one to export the carrier wave 

functions. The output file contains the following variables stored in columns separated by 

tab: 

� Position (nm) 

� Conduction band, valence band, electron Fermi level, hole Fermi level (eV) 

� QW indicator which equals to 1 if the point belongs to one of QWs and 0 otherwise 

� Carrier wave functions (nm1/2)  

 

Wave functions are named as follows:  

QW<QW index><carrier type><level index>,  

where letters EE, HH, LH, and SH denotes electrons, heavy holes, light holes, and split-off 

holes, respectively. 

5.4 Emission Spectra 

The Export | Emission Spectra menu item enables one to export the emission spectra. The 

output file contains the following variables stored in columns separated by tab: 

� Energy (eV) 

� ETotal (cm-2 s-1 eV-1) – total emission intensity 

� EQW1 (cm-2 s-1 eV-1) – emission intensity from the 1-st QW 

� EQW2 (cm-2 s-1 eV-1) – emission intensity from the 2-nd QW 

� …… 

� EQWN (cm-2 s-1 eV-1) – emission intensity from the last QW 

 

The following data are the same intensities normalized to the wavelength 

� Wavelength (nm) 

� WTotal (cm-2 s-1 nm-1) – total emission intensity 

� WQW1 (cm-2 s-1 nm-1) – emission intensity from the 1-st QW 

� WQW2 (cm-2 s-1 nm-1) – emission intensity from the 2-nd QW 

� … 

� WQWN (cm-2 s-1 nm-1) – emission intensity from the last QW 
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Warning:   One should plot the data form the first group vs the energy, and from the second 

group vs the wavelength in order to keep the right normalization of the intensity to the total 

recombination rate! 

5.5 Gain Spectra 

The Export | Gain Spectra menu item enables one to export the gain spectra. The output file 

contains the following variables stored in columns separated by tab: 

� Energy (eV) 

� ETotal (cm-1) – sum of the following columns 

� EQW1 (cm-1) – gain in the 1-st QW 

� EQW2 (cm-2 s-1 eV-1) – gain in the 2-nd QW 

� …… 

� EQWN (cm-2 s-1 eV-1) – gain in the last QW 

� Wavelength (nm) 

5.6 Overlap Integrals 

The Export | Overlap integral menu item enables one to export the overlap integrals. The 

output is a text file. The data are arranged similarly to their appearance in the Overlap 

Integrals window (Sec. 4.3.4). 

5.7 Waveguide Modes 

The Export | Waveguide Modes menu item enables one to export the gain spectra. The 

output file contains the following variables stored in columns separated by tab: 

� Position (nm) 

� Refractive index for ordinary wave 

� Refractive index for ordinary wave modified – see details in [1]. 

� Refractive index for extraordinary wave modified 

� Refractive index for extraordinary wave modified – see details in [1]. 

� FieldTE1 (cm-1) – squared electric field for the 1-st TE mode 

� FieldTE2 (cm-1) – squared electric field for the 2-nd TE mode 

� …… 

� FieldTEN (cm-1) – squared electric field for the last TE mode 

� FieldTM1 (cm-1) – squared electric field for the 1-st TM mode 

� FieldTM2 (cm-1) – squared electric field for the 2-nd TM mode 

� …… 
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� FieldTMN (cm-1) – squared electric field for the last TM mode 

5.8 Laser Characteristics 

The Export | Laser Characteristics menu item enables one to export the laser characteristics. 

The data are arranged similarly to their appearance in the Table tab of the Laser 

Characteristics window (Sec. 4.3.7). 

6 Solver Parameters 

The section describes the solver parameters in the Global parameters tab window.  

6.1 Main Solver Parameters  

Precision parameter allows to increase the accuracy of the floating-point numbers in bits 

during the core computations and improve convergence. It is recommended to increase 

precision up to 256 in case of any problems with convergence. Variants "double" and "64" 

are very similar, the difference is that "double" is realized with default compiler options and 

"64" with the library for extended precision. 

 

The grid is generated automatically by the procedure described below. First, the basic mesh 

step is chosen for each layer, which is equal to Basic mesh step for thick layers and Basic 

mesh step for thin layers, for layers with thickness higher and lower than Thin layers are 

lower than parameter, respectively. The grid step in the central part of the layer equals to 

this basic mesh step. The mesh step adjacent to the layer boundaries equals to Boundary 

mesh step. Then the mesh step is increased by the factor of Mesh refinement factor until it 

reaches the basic mesh step. 

 

Some parameters controlling the computations are shown in the solver window. One can 

update them even during the computation and see its effect on the convergence. 

6.2 Spectrum Solver Parameters  

The spectrum solver generates a separate uniform mesh for each quantum well to solve the 

Schrödinger equation. The user should specify the Mesh step in the respective text field. The 

recommended mesh step is about 0.05-0.2 nm. Effective LAPACK computational routines [2] 

are used to solve the eigenvalue problem. 
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The Minimum energy level and Wavefunction damping in a barrier parameters are used for 

determination of the computational domain boundaries for each quantum well, as described 

in Sec. 10.2 of [1]. They are rarely needed to be modified. Generally, quantum wells with the 

barrier heights smaller than the value of the former parameter are ignored in the spectrum 

calculation. The last parameter determines the minimum damping of the wave function at the 

domain boundaries. The higher this parameter, the wider barrier regions are included in the 

domain. 

 

The Maximum number of levels in a QW parameter is introduced to limit the maximum 

amount of the heap memory and computation time needed for the solution of the 

Schrödinger equation. If there are more levels exists in the quantum well, only first several 

levels will be calculated according to the maximum number.  

 

The Spectrum broadening parameter determines the width γ  used to calculate the spectrum 

broadening as discussed in Sec. 10.6 of [1]. 

 

7 Editor of Material Parameters 

The Properties Editor  is an additional tool for editing input data for materials properties. It is 

supplied free of charge with STR programs requiring these data. The input data are saved in 

the special project files of the Properties Editor . Other STR programs load material 

properties from these files. The default database of the material properties is supplied with 

the package.  

The user can modify the properties of the existing materials as well as add new materials by 

using Properties Editor . Database files are stored in ASCII XML format. Advanced users 

may directly edit it via text editor to change material properties.. 

Generally, the materials in the Properties Editor  are divided into two types: (i) materials of 

fixed chemical composition, like GaN, GaAs, etc. and (ii) alloys with variable composition, 

like AlxInyGa1-x-yN, AlxGa1-xAs, etc. Alloys are formed from existing materials (at least two 

materials are needed to make an alloy). In Sec. 7.3 we will consider different ways for 

specification of properties of materials and alloys. 
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All materials and alloys are divided by their crystal symmetry, which is shown in the drop-

down list in the top part of the window. The current version supports two symmetry types: 

zinc blende and wurtzite. 

7.1 Materials Tab Window 

Left part of the Materials tab window contains list of existing materials and buttons to 

manipulate with them. The right part of the window represents properties of the selected 

material. Properties are divided into several groups: electronic, optical, lattice-related 

properties, properties of impurities, etc. 

To create new material or delete existing material, use buttons Add Material or Delete 

Material, respectively. Buttons Copy Material and Insert Material allows one to copy selected 

material into a buffer and insert material from the buffer after selected material, respectively. 

One can arrange materials in the list by buttons Move Material Up and Move Material Down. 

Material name is an arbitrary string specified by user which serves as a unique identifier of 

the material. As created, new material has all properties initialized with default value (mainly 

zero). For each material property, one can edit the specification type (green column) and the 

value. 

7.2 Alloys Tab Window 

Left part of the Alloys tab window contains list of existing alloys and buttons to manipulate 

with them. The right part of the window represents how the material properties of the 

selected alloy are interpolated for an arbitrary material composition. The list of properties is 

similar to the Materials tab window. 

Use button Add Alloy to create new alloy. A modal window Add Alloy appears where you are 

prompted enter alloy name. The list of materials of the selected type will appear. Mark 

materials you want to include in the new alloy. At least two materials are necessary to form 

alloy. As created, new alloy has all properties initialized with default value (mainly it will be 

zero bowing parameters, i.e. assumption of linear dependence of the property on the alloy 

composition). The number of bowing parameters is n(n-1)/2 , where n is the number of 

materials in the alloy. For each material property, one can edit the specification type (green 

column) and the value(s). 
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7.3 Specification of Properties 

There are three different ways for specification of the properties of a material (types of 

property):  

� constant values for materials and bowing parameters for alloys (default); 

� user-defined functional dependence 

� pre-defined parameterization (available for some properties) 

To change the property type one needs click the respective cell of the table and pick up new 

type from the drop-down list appeared. 

7.3.1 Default 

Most of the properties are specified by setting constant values for materials and bowing 

parameters for alloys. Then property f  of alloy including n species is calculated as 

∑∑∑
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of the property f  for pure materials, and ikf  are the bowing parameters. One can use zero 

bowing parameters to describe linear variation of the property f  with the alloy composition, 

so called Vegard law. 

7.3.2 Functions 

Functions can depend on the temperature and wavelength (the latter is useful for optical 

properties like refractive index). Functions used in properties of alloys can also depend on 

the alloy composition. Functions can be specified by writing a Pascal-like script or by 

providing a tabulated dependence of the property on one of the function arguments. 

Functions are edited within a special Functions Editor window available by using 

Functions menu item. 

To set a function for a property one needs change property type to function and then 

pick up the function name in the drop down list in Value column. For alloys, the function 

name is shown instead of value of the first bowing parameter. 

NB:  Note that using functions may lead to the situation when the property of a material may 

differ from the property of the alloy which is in fact 100% consists of this material. For 

instance, we have AlN, InN, and GaN materials and AlxInyGa1-x-yN alloy made of these 
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materials. If some property of AlxInyGa1-x-yN alloy is specified with a function, it may happen 

that its value for x=y=0 (i.e. the case when alloy entirely consists of GaN) differs from the 

value of this property in GaN material. This situation may lead to confusion when simulation 

results depend on how GaN layers are specified - as GaN material or as AlxInyGa1-x-yN alloy 

with x=y=0 composition. 

7.3.3 Parameterization 

Some properties can be calculated form other properties by pre-defined equation 

(parameterization). All the pre-defined parameterization are discussed in details in [1]. 

One can use function (or, generally, even constant) instead of parameterization. To 

make property be calculated with the parameterization one needs change property type to 

parameterization. For alloys, the respective string is shown instead of value of the first 

bowing parameter 

 

8 Frequently Asked Questions 

8.1 Should I always start from n-type layers in ‘He terostructure’ list?  

Yes, the ‘Heterostruture’ list has a fixed direction, from n-side to p-side, no matter what is the 

actual growth direction. Besides, in all graphs representing the heterostructure (band 

diagram, waveguide modes, etc) direction from left to right corresponds to the direction from 

n-side to p-side. 

8.2 What should be the first heterostructure layer?   

If you are simulating an LED with planar current spreading, the first heterostructure layer to 

be thick n-type contact layer responsible for the lateral current spreading. You need not input 

nucleation buffer layers. For instance, your real structure looks as: 

1. Sapphire substrate 

2. Nucleation layer 

3. Buffer layers 

4. Undoped GaN 

5. 3 um n-GaN  

6. LED structure layer 1 

7. LED structure layer 2 

8. …. 

Then your input in SiLENSe should be only 
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1. 200 nm n-GaN  

2. LED structure layer 1 

3. LED structure layer 2 

4. …. 

The reason is that SiLENSe assumes that the current flows through all the layers specified in 

'Heterostructure' tab of SiLENSe. Also, you can reduce the thickness of the first layer down 

to 200-300 nm (far away from the active region the current is governed just by the Ohm law). 

8.3 Some materials (sapphire, SiC) have a lack of p roperties  

As for sapphire and SiC materials, they was included to database only for their optical 

properties, since they are important for computation of the waveguide modes in laser diodes 

(see substrate specification in the 'Laser parameters' tab). We do not expect their use in the 

'Heterostructure' tab, so we do not care about their properties except to the refractive index 

and related parameters. 

8.4 Non-radiative recombination parameters  

The non-radiative recombination is calculated as a sum of contributions of dislocations, point 

defects, and Auger recombination (Eq. 6.1 of SiLENSe Physics Summary). Both dislocations 

and point defects are described within the Shockley-Read-Hall approach. We have 

developed a special model which relates the dislocation density to the carrier non-radiative 

lifetimes. Direct input of the lifetimes is also possible in respective text fields. Blank value for 

both electron and hole non-radiative lifetimes results in zero recombination. If one value is 

blank, while other is filled, the only filled field is taken into account. For instance, if tau_e 

=1ns and tau_h = "blank", R = n/tau_e . 

 

Thus, the user can use the model and input dislocation density (with blank recombination 

lifetimes because of point defects) or input lifetimes directly with zero dislocation density. 

Use of both dislocation density and lifetimes is possible, but in this case the lifetimes must 

describe the contribution of the defects except to the dislocations. 

 

Some people claim that Indium fluctuations may improve IQE by capturing carriers and 

preventing them to reach dislocations. We have developed a model to describe this effect. 

The model needs characteristic fluctuations in the energy of the conduction and valence 

bands. It is assumed that DOS decays exponentially inside the energy gap. Details are given 

in Sec. 6.2.1 of SiLENSe Physics Summary. 
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The sum U_n+U_p is suggested to be nearly equal to the characteristic decay energy of the 

low-energy (long wavelegths) wing of the emission spectrum. It was experimentally found to 

about ~50 meV for different structures. Then, we suggest that U_n/U_p ratio equal to the 

ratio between band offsets dEc/dEv = 7/3 . So, the default values are 35 and 15 meV for 

conduction and valence bands, respectively. 

8.5 Degree of relaxation in layer properties  

By default, SiLENSe assume that all layers are grown pseudomorphically. There is an idea 

that at high In content real QWs are partially relaxed. In SiLENSe, the user can specify a 

degree of strain relaxation for each layer. Please keep in mind that if you set some strain 

relaxation in QWs, you have to simultaneously set complete strain relaxation in the next 

barrier or electron blocking layer. Otherwise, next layer will inherit lattice constant from the 

underlying QW. Example of an SQW structure with 50% strain relaxation is supplied with the 

program. Section 2 of SiLENSe Physics Summary contains all details of computation of the 

strain and the piezoelectric field. 

8.6 What is the Indium composition fluctuation mode l ?  

Some researchers believe that Indium fluctuations may improve IQE by capturing carriers 

and preventing them to reach dislocations. We have developed a model to describe this 

effect assuming that density of states (DOS) decays exponentially inside the energy gap. 

The only input parameters for the model are characteristics energies for DOS decay for 

conduction and valence band, Un and Up, respectively. 

 

The default parameters were estimated as follows. The sum of Un and Up is suggested to be 

nearly equal to the characteristic decay energy of the low-energy (long wavelength) wing of 

the emission spectrum. The latter was experimentally found to be about ~50 meV for 

different structures. Then, we suggest that Un / Up ratio equals to the ratio between the band 

offsets ∆EC/∆EV = 7/3 . So, the default values are 35 and 15 meV for conduction and valence 

bands, respectively. Details are given in Sec. 6.2.1 of SiLENSe Physics Summary. 

8.7 Why SiLENSe does not compute the reverse curren t density?  

The reason is that there is no good model for the carrier transport in III-nitride p-n junctions 

under reverse bias (and under a low positive bias, say below 2 V). The conventional drift-

diffusion model considers the reverse p-n junction current as a current due to the thermal 
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carrier generation in the depletion region and its proximity (~ diffusion length). This approach 

predicts the reverse current density many orders of magnitude lower that the experimental 

one, because wide bandgap leads to very low thermal carrier generation. 

 

On the other hand, in III-nitride LEDs the reverse current density (as well as that at low 

positive bias below) is governed by the carrier transport along the extended defects 

(dislocations, grain boundaries). At least, there are many experimental observations that the 

reverse current is suppressed by increasing the crystal quality. 

 

Description of carrier transport through the defects is beyond the model of the carrier 

transport implemented in SiLENSe. Instead, we assume that Fermi levels for electrons and 

holes are constant. This approximation is quite realistic and allows calculation of the band 

diagram under reverse bias. Having the band diagram, we can compute the carrier energy 

levels and wave functions in the same way it is done at positive bias. 

8.8 Why SiLENSe underestimates the current at low b ias for III-nitride 

LEDs?  

The reason is basically similar to the considerations in the above section titled "Why 

SiLENSe does not simulate reverse current". Under a low positive bias (say below 2 V) the 

current density due to the carrier leakage along the extended defects is much higher than 

conventional injection current density. 
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